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1. Introduction 
 

So how did I get started with digital cameras? 
My introduction to digital cameras was in 1999 when choosing a method for getting still 
pictures back from ocean racing yachts. Digital cameras made it easy to get the pictures 
home over a satellite link. The compact digital cameras also came with tough waterproof 
housings which I was able to take diving… 
 
…which is where my interest took off and, once I’d got more confident underwater, so did the 
photography. Since 2001 I have been taking pictures in earnest and whilst there’s some way 
to go before I’d rate myself as more than competent or at all artistic, I’ve enjoyed it much more 
than I did waiting for my pictures to be developed in the old days. 
 

What’s the big idea? 
A new digital camera won’t make you a great photographer, photography is an art and you 
may or may not be an artist, yet! But digital cameras do make it easier to get good results 
since you can see your results straightaway and correct mistakes. It doesn’t cost any more to 
take 1, 10 or even 100 pictures you can afford to keep going until you get the one you want. 
 
Using a film camera I bought in 1983 I used about 70 films - about 2500 pictures in 18 years. 
Now I take more and more pictures every year, since 2001 I have taken roughly 100,000. 
 
Digital pictures make new things possible too, especially new ways to share pictures, and this 
means you can get pictures to the people you want to see them. To unlock all this great stuff 
you really do need access to a PC and that’s usually where things start to get tricky. The aim 
of these workshop notes is to help you become aware of what is possible with digital imaging 
in general and aware of the advantages and pitfalls of using a PC. Hopefully this will help you 
on the way to getting the results you hoped for when you first bought your camera. 
 
This workshop is a taster for the full course which now runs for a total of 15 weeks in three 
parts. The beginners, intermediate and advanced sections each lasts for 5 weeks and cover 
common problems and useful techniques in much more detail than we can in the workshop.  
 

My get out clause… 
The information in this package is a summary for digital photography and not an in-depth 
computer literacy or photography course. I hope it’s useful and appropriate, in some cases a 
single situation is presented as a de facto method to avoid extensive explanation during this 
short workshop. This is not intended to patronise and if you feel any area has been glossed 
over please ask for more information. 
 
This course is PC based using Paintshop Pro and Picasa software– the latest versions 
available at the time of writing. The principles shown are the same in other versions and 
similar programs. 
 
Rob Spray 
robert.spray@bt.com 
April 2008 
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2. Computer basics 
 

Getting used to mice 
Trying to move a mouse at arms length is usually imprecise. Most experienced users plant the 
heel of their hand and make small mouse movements with their fingers, only lifting their whole 
hand when they need to make bigger movements. This usually allows improved control for 
subtle changes and even makes clicking more accurate. 
 

Species of mice 
There are two common types of mice; mechanical and optical. When new, they both work 
pretty well but the mechanical ones fill with dirt, hair and mystery crud that has to be removed 
periodically. Optical ones don’t clog and work on uneven surfaces. Cordless things have 
become much cheaper and a wireless keyboard and mouse can clear clutter from your desk – 
rechargeable ones are worthwhile as it can be confusing when your mouse goes flat! 
 

Tablets 
People who do a lot of work with pictures often use graphics tablets, flat plastic pallettes 
where you use a pen-like ‘stylus’ instead of a mouse. People are used to pens and brushes 
for precise work and so these can be more pleasant to use. While they allow fine control they 
aren’t so intuitive for menus. They are usually wireless and can coexist with your mouse. 

 
Hard Discs 
There is just one rule when buying hard discs – buy the biggest you can. Whatever you do will 
fill any disc so having more space than you need is a problem that rarely lasts long. It is very 
easy, though slightly more costly, to add extra external discs via USB2 ports. A nice feature of 
external drives is that they can be moved from PC to PC when you upgrade or travel. 
 

CD (and DVD) burners 
Hard discs are great for huge storage but are mechanical and don’t last forever, a back up 
store that doesn’t wear is vital. CDs have been around since 1983 and are versatile and 
tough. Store CDRs (writeable CDs) somewhere dark. USB ones are easier to fit. 
 

Memory 
When working with large pictures memory is more important than the processor speed of your 
computer, if you can fit 1GB (or more) to your PC it will help. 
 

Screens 
If you spend a long while at a computer nice, flat LCD screens are more restful than the old 
style but need to be adjusted carefully. Usually people have the contrast and brightness both 
up too high. To see your pictures properly make sure that while white is bright and black is 
dark you can still see the subtle shades between. Set black with the brightness control, then 
set contrast so that white is comfortably bright. 
 

Windows 
With Windows newest isn’t always best, Vista and XP can be slow on old PCs, Windows 98 is 
past it now. Windows 2000 is a good compromise as it runs reasonably fast on old machines. 
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3. Picasa 
 
I used to cover downloading in much greater detail but life is now much simpler than it used to 
be and newer versions of Windows will even volunteer to extract your pictures from your 
camera. Even better than this there are excellent free programs which will take most of the 
stress out of the important, basic bits of digital photography. The best program I have used is 
called Picasa and is worth every penny! It’s free! 
 
Picasa isn’t hard to get to grips with so this isn’t a manual, just some pointers to get you 
started. The best way to learn is to experiment, which is safe with Picasa – as you’ll see in a 
few pages time. 
 

Downloading 
Once it is downloaded and installed (from picasa.google.com N.B. No www) it should spring 
up whenever you connect a camera or some storage which has pictures on (including CDs) 
and offer to download them. Not only that it will keep track of the ones you have already 
removed from the card if you are the kind of person who doesn’t wipe the card every time – 
like me. 
 
Windows XP and Vista have a camera download wizard which does a similar thing, though 
not as well and not as simply. 
 
Although Picasa is very good there are a few things to keep an eye out for to make sure all 
goes smoothly. 
 

Detecting ‘media’ 
The default setting for Picasa allows it to keep an 
eye out for new pictures arriving on your 
computer. Your camera’s own download software 
and windows might be trying to do this as well. 
Usually the last program takes precedence but 
this can be upset and if Picasa isn’t responding 
then you should check the settings. 
 

Tools > Options > General tab 
If there is no tick in the boxes for 
Automatically detect media and 
Automatically detect duplicate files when importing 
then click on them so that a tick appears 

  

Set your picture store 
Deciding where you want your pictures to go means 
you’ll know where they are when you want work on 
them. Picasa allows you to set the folder where new 
pictures are stored, a new sub-folder is created for 
each download. 
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The default for Picasa (and Windows) is a folder on the system hard drive called My Pictures. 
This is OK but a very big collection of pictures could clog and slow your system so it is better 
to store them on another partition or drive. 
 

Tools > Options > General tab 
At the bottom of the box) is the setting 
Save Imported Pictures In 
Which allows you to browse to the folder you would prefer 

 
Your system drive is almost always called the C: drive, if you have another it will probably be 
called the D: drive. There may not be another hard drive area. You will also have a CD or 
DVD drive with a letter of its own, which may be D: if there is no other hard drive. 
 

Index Scanning 
Picasa scans your PC for pictures, but only where it has been told to look. Downloaded files 
will be included in its index but sometimes pictures won’t appear. To add folders to the index 
needs another sortie into Picasa’s menus. 
 

File > Add folders to Picasa 
This takes you to the folder manager where you can select which folders are 
scanned and indexed. They can be indexed Always, Once or Never. Choose 
Never for folders which don’t interest you. 
 

These pictures are not ‘in Picasa’ it is 
just indexing them so you can view 
them. It will not upset any other 
program which can see them. 
 

Patience 
The indexing process runs in the 
background to avoid slowing your 
computer too severely. This means 
that pictures do not always appear 
instantly. Sometimes it can take quite a 
while. Either wait patiently or set the 
folder to Never and then back to 
Always and it should turn up quite 
soon. Stopping and restarting Picasa 
can also give it a kick to index new 
pictures. 
 
Don’t panic and download everything again – all of them will turn up eventually. 
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4. Playing with pictures in Picasa 
 
Repeated note: Picasa isn’t hard to get to grips with so this isn’t a manual, just some pointers 
to get you started. The best way to learn is to experiment, which is safe with Picasa. 
 
Once downloaded Picasa’s picture handling is broken down into three areas. These show 
once you have selected a single picture - by double clicking on it. Each set of tools is selected 
by tabs high on the lefthand side. These allow you to make basic improvements, fine tune the 

picture or add some fun effects. 
 
 

Basic fixes 
The basic fixes are all the most useful things that all 
photographers whether amateur or professional will find 
their pictures benefit from. It is perfectly acceptable to 
crop or straighten a photo – professionals do it all the 
time. 
 
 
 
 
 
 
 
 

 

Tuning 
This set of tools allows you to ‘tune’ the appearance 
of the picture. It doesn’t offer the complete control of 
a more complicated program like Paint Shop Pro or 
Photoshop but copes with most jobs. 
 

 
 
 

Effects 
The effects are a varied set of useful and fun ways to 
change your pictures. The names are pretty self 
explanatory so the advice is to try them out. The Soft 
Focus effect is very good for portraits and the Black 
and White or Sepia ones can add a bit of atmosphere. 
The Sharpen effect isn’t so good and can make pictures 
look quite grainy. 
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5. Don’t go changing 
 
One of the most important aspects of Picasa’s behaviour is that none of the changes it makes 
actually change your original file… I know you can see the change in Picasa but you’ll find 
that other programs don’t see any difference if you view the same pictures with them. You can 
also undo any changes made in Picasa, all the way back to the original version. 
 
This is both good and bad… your pictures are safe but you can’t see your work on them 
anywhere else… until you export them. 
 

Export or die 
Picasa can export it’s pictures in a 
number or ways… it can make 
small versions and put them into an 
e-mail ready to send, create 
slideshows and of course it can 
produce new, changed versions of 
your pictures. 
 
You’ll find the Export button down 
at the bottom right, 
 

 
 
clicking it will produce a new folder 
containing changed versions of any 
pictures you have selected – so it 
can do 10s or 100s in one go. 
 
The new files are produced to the 
settings chosen in box which pops 
up (see right) and also asks you 
where to put them. 
 
The settings for E-mail and slideshows are accessible though appropriately named tabs in 
Picasa’s Tools > Options menu (again). Using the e-mail facility does require that Outlook 
Express is set to be your default e-mail program in Window control panel and does not work 
with Hotmail or most other webmail services. 
 
 
Playing with Picasa can be great fun and very quickly make a big difference to your pictures. 

It has its limits but for the price you can’t complain ☺ 
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6. Mastering file wrangling! 
 
The biggest problem with ‘digital cameras’ is not the cameras themselves but the computers 
that are needed to make the most of them. Most people have some trouble transferring, 
copying and managing the files that their pictures have become. 
 
The first step to getting a grip on your photos is to keep track of where they are. Many of the 
‘free’ programs which come with cameras are quite sneaky and hide your files away in virtual 
albums – this can make them difficult to find when you want to use other programs to improve 
your pictures. 
 
I don’t use the free software that comes with cameras for transferring pictures and unless you 
find it does everything you need I’d recommend you don’t either – a good reason is that most 
hide your files away in ‘albums’ which make them hard to find when you want to use them. 
 

So what can you do? 
 
Transferring pictures from cameras is usually very easy. When 
connected many cameras will appear as an extra ‘removable’ disc drive 
on your computer, a card reader certainly will. There are a couple of 
‘layers’ of folders on camera cards, you will find the pictures in one or 
more numbered folders inside the DCIM folder. These folders are 
named with a number and an abbreviated version of your camera 
maker’s name – in this case OLYMP = Olympus. 

 
Put a shortcut to the DCIM folder on your desktop, call it something useful. (DCIM is 
short for Digital Camera IMages). Don’t make a shortcut to the number folder - your 
camera make different ones regularly. 
 
Choose an easy to find area of your computer (preferably not on your C: drive), 
create a folder, label it clearly and put a shortcut to it on your desktop. 
 
With both folders open (double click the shortcuts) drag the numbered folder you want from 
your camera folder into your pictures folder and drop it there. The default action is that it will 
copy across (a small + sign will be shown on your cursor). 
 
The mysterious numbered folder is now in your pictures folder. You can rename it so that it is 
less enigmatic and so easy to identify. 
 
You might want to gather your renamed folders together in further 
folders for years or themes, this will help sort them once you have a 
large collection. 
 

 
 
To do all this magic you just need to know a few things… 
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7. Basic File Fighting 
 
In the various versions of windows there are nearly always several ways to do any particular 
task and people vary as to which one they prefer (or can remember). With the recent versions 
of Windows there is a fairly simple rule which will help you access the tools to perform the 
basic tasks. 
 

‘The left button is for actions, the right button will list what they are’ 
 
So in many cases if you want to do something right click on the place or thing you would like it 
to happen to and you may be offered the chance… 
 
N.B. Some of these options are shown under the ‘File’ menu of many programs 
 

Making new folders 
In a folder (this includes the desktop which is a special folder) right click in some blank space 
and you will be offered a list of options, ‘mouse’ over to new and you will get a choice of all 
the new things you can create. The first on the list is a folder! Left click on that choice. 
 
A new folder will appear and the 
label ‘new folder’ will be already 
selected (dark) – just type the 
name you want and press return. 
You will have a new, usefully 
named folder ready to fill. 
 
 

Creating short cuts 
As you can see from the last 
picture the second option is to 
create a shortcut so just right click 
on the thing you want to make a 
short cut to and left click on create 
shortcut. A new shortcut will 
appear, drag it to the place you 
want it and drop it there. 
 
 
 
 
Warning: Shortcuts can look much like folders but are just labels and can be moved very 
quickly – make sure you have moved the shortcut not the original!  
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Renaming files and folders 
Again right click on the file or folder you would like to rename and you will be offered the 
chance to rename it. The old label will be selected (dark) – just type the name you want and 
press return. 
 

Dragging and dropping 
This is the simplest way to move and copy things. To ‘drag’, left click an item, keep the button 
held down and move it to the folder window where you want it to be, then ‘drop’ the item there 
by releasing the mouse button. 
 
Dragging and dropping can work in a number of ways. If there is no additional symbol by the 
dragged icon the action will move the file, if an arrow appears it will make a shortcut. Which 
action it chooses is dependant on what you are moving and to where – it is trying to help. 
 
You can force it to do what you want by holding down the following keys while you drag and 
drop… 

The Ctrl (control) key to make it copy 
The Alt (Alternate) key to make a shortcut 

 

Shortcuts - Copying and Pasting 
You may have seen that right clicking offers you the option to copy and paste, an even easier 
way to do this is with ‘shortcut keys’. 
 
For example to copy a file: 
Left click on it 
Press and hold ‘Ctrl’ and then press ‘C’ 
Left click on the place you want the copy to go 
Press and hold ‘Ctrl’ and then press ‘V’ 
 
One of the most useful shortcuts is Undo 
Press and hold ‘Ctrl’ and then press ‘Z’ 
This will (usually) undo the last thing you did 
 
N.B. These shortcut options can often be found in the ‘Edit’ menu of programs and are often 
described as ‘Ctrl-C’ etc - you may see other options in manuals. 
 

Worth remembering 
Many programs allow you to use the right click option list in this way, drag and drop things 
from place to place and also use shortcut keys for copying and pasting. 
 
Bear in mind that these options are ‘context sensitive’ and the options, and ways that they 
work, may change depending on which program you are using. 
 
Most actions can be undone, either with Ctrl-Z, or just by not saving the result. Another good 
idea when you are working with precious pictures is to make a copy and never work on the 
original. 
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8. Why is it so slow? 
 
Most people find digital cameras are slow to take pictures. The bulk of the delay is due to the 
time the camera takes to focus, a little due to it measuring exposure and there is a pause 
before the next picture can be taken. 
 

Pre Focus 
 
Almost all cameras allow you to ‘pre-focus’. When the 
shutter button is half pressed the camera will focus (slowly 
as usual) then it waits whilst the button is held there. When 
it is fully pressed the camera will take a picture almost 
instantly. This needs a bit of planning but it is quite possible 
to catch split second actions. 
 

Exposure Lock 
 
A side effect of half pressing the shutter to pre focus is to also fix the exposure to suit the view 
when the button was half pressed. This can be used to your advantage too. If your subject is 
in silhouette, pre-focus the camera on something else the same distance away (their feet?) 
and then frame them in the viewfinder and fully press the shutter. 
 
If your camera allows manual exposure this can save a little time but this usually complicates 
snap shooting and is best practiced on something less important. 

 
Manual Focus 
 
If your camera allows manual focus you won’t have to repeatedly pre-focus once you have set 
it and the shutter will be as fast for each shot 
 

Shot-to-shot delay 
 
The camera stores each picture on a memory card and doing this may delay taking the next 
picture, more megapixels take longer to save too! Most cameras have a memory buffer which 
allows several pictures to be taken quite rapidly but they will still slow once this is full. 
 

Flash cycling 
 
Another contributor to the delay between shots can be the time taken for the flash to 
recharge, this will get longer when the batteries start to run down. Cameras with more or 
bigger batteries will be faster. 
 

Lighting 
 
The camera’s autofocus will be faster in strong light, like you it needs to see to focus. Some 
cameras are hopeless in the dark whilst others are just slow. Some have lights to help them 
focus in the dark – these have limited range. 
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9. Pictures and pixels 
 
Picture size 
When we discuss the size of digital camera pictures, in megapixels of course, we are not 
talking about their physical size. As they are digital, and don’t have a physical size, we are 
describing the potential detail in their equivalent of a negative. In fact with film this was what 
people always discussed when they were talking about 35mm, 110, 126 and APS cameras. 
Far from being confusing, megapixels are a very simple rating of how sharp digital pictures 
could be, but a blurred picture is blurred no matter how many pixels it has. 
 

How many pixels do you have? 
This is important. Not only for boasting, but to determine how large you can print your pictures 
and how much space it takes to store them. It also affects how aggressively you can crop and 
alter your pictures. 
 

How many do you need? 
More pixels are potentially better but whether 
you need ‘better’ depends on what you want to 
do with your pictures. Most cameras of 2 
megapixels and over can make good standard 
size (6”x4”) prints. It’s best to buy a camera 
suitable for the most demanding thing you 
hope to do – then it should be fine for the less 
critical jobs you have. The ‘most demanding 
thing’ is usually the largest print you would like. 
 

Pixels 
‘Pixel’ is a contraction of ‘picture element’, with an ‘x’ rather than a ‘c’ just to make sure 
everyone would say it the same way. 
 
A picture made of pixels is rather like a mosaic. A good mosaic uses lots of small tiles to 
create a detailed, lifelike image. In comparison, a simple mosaic appears coarse because you 
can clearly see each tile and even the 
detailed mosaic ‘breaks up’ into blocks 
when we get close enough to see 
individual tiles. 
 
Like a mosaic, a digital picture is made up 
of many separate coloured dots (the 
pixels) and when the 
dots become too 
small to see the 
picture is ‘perfect’. 
 
 
 
 
 

Picture size Megapixels 
(nominal) 

Width Height 

Megapixels 
(real) 

1.3 1280 960 1.228,800 

2 1600 1200 1,920,000 
3.2 2048 1536 3,145,728 

4 2288 1712 3,917,056 
5.1 2592 1944 5,038,848 

7 3072  2304 7,077,888 

8 3264 2448 7,990,272 
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The point where the pixels ‘blend’ is the appropriate viewing distance for that print or display. 
This property means that there are various informal ‘agreed pixel densities’ in use, most 
people don’t notice them at all – which is the whole point! 
 

Resizing 
Sending huge pictures to people without warning can make you quite unpopular and will 
continue to do so until everyone has broadband. It’s worth making your pictures small enough 
to send quickly and view within a normal screen. Most people can more easily cope with 
pictures which are about 640x480 pixels (only 0.3 megapixels) without the need for a program 
like Paintshop Pro. 

 
Resize is found under Image > Resize 
This opens a sizeable box of options.  At the top there’s a summary of the picture’s properties. 
You can see that it has been given the ‘standard’ screen ‘Resolution’ of 72 PPI. This low 
value results in the vast size in brackets. This is the 
size that the picture would be on a screen big enough 
to view the whole thing at ‘100%’. 
 
There are several ways to change the size of the 
picture. The easiest is to change a value in one of the 
‘Pixel Dimensions’ boxes. If ‘Lock aspect ratio’ is left 
ticked then the other box will change too – to maintain 
the proportions (aspect ratio) of the picture. 
 
The other controls which affect the ‘print size’ are more 
confusing and best avoided until you find your feet with 
this jargon – they do the same thing in a different way.  
 
Nestling at the bottom of the box is one of the most 
important controls. It may seem strange that there is a 
choice of ways to scale the picture up and down but 
there is and some of the choices can make quite a 
mess of your picture. The resample box should be 
ticked and the ‘Smart Size’ method is the most 
generally useful option here. 
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10. Picture tools  

 
There are many tools to modify your picture, some which can alter large areas and others for 
delicate changes. Although we discuss Paint Shop Pro here most programs use similar 
symbols and terminology for a similar range of tools. Some are more useful than others… 
 
Each tool shown is actually one option from several choices, the others can be seen by 
clicking  on the small arrow to the right of the icon (Version 8) or right clicking on it (Version 7 
and earlier), have a look at them all. 
 

The pointer (arrow) is less useful than its companion - zoom (the magnifying glass). 
Left click to zoom in and right click to zoom out. Working zoomed it is usually easier to 
be more precise. (If you have a wheeled mouse that will zoom you in and out too!) 
 
The crop tool is very handy, use it to trim the picture for best effect. 

 
The select tool can be used in many ways. There are several variants which allow you 
to select different shaped areas either to move, remove, copy or alter. 
 
The paintbrush isn’t as useful as you may think, it’s very hard to be subtle. 
 
Clone – THE tool for correcting mistakes and removing blemishes/relatives 
 
Photo tools - this selection is vital for blending changes back in. 
Blur is one of the options, it sounds awful but is actually very useful. This selection 

also includes Sharpen, Dodge/burn (photographic jargon for lighten and darken) and Smudge 
(an often messy way to blend in changes) 
 

Adjustments – has some similarity to the photo tools, includes… 
Lighten/darken – is useful for lifting people out of shadows or flattening highlights. 

This selection also includes Saturation (which adjusts the strength of colours) 
 

Text – useful for adding labels and captions. 
Caution! Can ruin your picture if placed badly without using layers (a subject in itself) 

 

Brush controls 
 

 
 
 

Each of the tools has a number of adjustments to modify the way it works. 
 
Size and shape are the most obvious but all can be useful. Its best to experiment with each to 
see the effect they have. Opacity (transparency) and hardness (sharpness of the outer edge 
of the brush area) can be useful for softening the action of tools when blending in new parts of 
a picture. 
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11. Selection 
 
On computers, whether you are working with files, words or pictures the concept of selection 
is very important. For file wrangling we selected folders, files or groups of files and then acted 
on them. Likewise words and letters, whether in e-mails, documents or file names can be 
selected and moved about in similar ways - usually with the same controls and shortcuts. 
 
When working with pictures selection can be used to control the way changes are made and 
is closely related to cropping where we trim the picture for better effect. 
 

Cropping 
 
We’ll start with cropping, as it is slightly simpler. To crop is to cut away unwanted 
outer parts to change the framing and composition of the picture. This could be to 

change emphasis or remove distracting detail, most pictures can be improved in this way. 
 
Once the crop tool is selected the first step is to select the first corner of a new outline for your 
picture. The first corner is left clicked and then the button is held until the cursor reaches the 
desired opposite corner. This ‘drag and drop’ produces an outline of the potential crop. The 
edges of the outline can be adjusted by moving the cursor over them until arrows appear, 
these can be clicked and dragged. The whole crop outline can be dragged and dropped if you 
have the cursor in the middle of the outline. If the outline is in completely the wrong place click 
well outside your desired area and then simply start again. 
 
When you are happy double click inside the outline and the section cropped from your picture 
will replace the original view. (If it’s not right you can undo the crop). A common use for 
cropping is to ‘square up’ a picture after straightening the horizon. 
 

Aspect ratio (picture shape) 
 
Before you finalise your crop consider what you want to do with the picture afterwards. Paper, 
monitors and TVs come in standard shapes so if you choose odd proportions it may not be 
easy to print or view your picture properly.  
 

Selection 
 

By default the selection tool works in a very similar way to the crop tool, a rectangular 
outline is dragged and dropped. Once this is done you could, in effect, make a crop by 

copying the selected part to a new picture but there are a lot of other options too. Different 
modes (such as freehand) are selected by clicking on the down arrow beside the tool icon. 
 
The selection doesn’t have to be rectangular, irregular selections can be made using the 
freehand mode to cut out details or precisely localise changes. The selection of an area limits 
operations to that region of the picture. We’ll explore those changes elsewhere.  
 
One of the prime uses for making a selection is to copy part of a picture into another picture, a 
fresh picture or to paste it into another programme – such as a document. The easiest way to 
‘copy and paste’ is with ‘shortcut keys’. 
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12. Picture tools - examples 
  
Dedicated picture editing programs such as Paint Shop Pro tend to have a lot more options 
than the ones which come free with cameras. The number of things that are possible can be 
bewildering, a few of the main ones are covered here. Try any you find intriguing – you can 
always undo the results! This section offers a few examples to get you started, it isn’t a full 
manual for Paintshop Pro – sorry!  
 
With a picture opened extra menus become available along the top of the program window. 
They each offer a lot of options, most operate using similar controls and preview windows.  
 

The Colours> Adjust menu 
 
Most tool options here can subtly adjust the properties of the picture. They are accessed by 
first selecting a category, then a particular tool. The most popular are: 
 

Colours> brightness/contrast 
 
Selecting this (and most other options) brings up a preview window. 
 

The – or + magnifying glass 
to zoom the views in or out  
 
The ‘crosshair’ can be dragged and 
dropped over a popup of the selection 
to move the views  
 
The ‘eye’ button previews your changes 
in the main picture window. 
 
The brightness control adjusts 
the black level of the picture. Set 
it so the darkest parts of the 
picture are black, or nearly black. 
 
The contrast control does what it 
says, use it sparingly or your 
picture will begin to look artificial.  
 
Most of the controls have a range of +/-100%. 
In general a 5-10% adjustment will be subtle, 

25-30% will be dramatic and approaching 100% will ruin your picture. 
 
The changes won’t be made for real until you press the OK button, and can still be undone 
after that. Cancel will stop any changes and close the preview window. 
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The Effects menu 
The most useful ‘effects’ are those for sharpening and repairing photos. The simple 
sharpening tools are easy but rather blunt and do either too much or too little – they tend not 
to work well on high resolution pictures as the details they effect can be too small to see! 
 

Effects > Enhance Photo > Red-eye Removal 
‘Red-eye’ it is quite easy to remove manually but there are automatic tools to help you 
 

When you move the cursor 
over the picture it becomes 
a crosshair, find the centre 
of the eye and left click. You 
will see how well the 
replacement has worked in 
the right hand preview 
window. 
 
You can select the colour 
and then the shade of 
replacement eye that is 
used and then finely adjust 
how well it fits and matches. 
 
Blending these new eyes in 
using the ‘refine’, ‘feather’ 
and other controls so that 
they look natural can take a 
little practice - they will be 

less obvious when the picture is back to its normal size. The ‘Delete Eye’ option lets you start 
again. 
 

The Image menu 
The image menu includes some very useful options and luckily they are some of the easiest 
to use and understand. ‘Flip’ and ‘Mirror’ do exactly what they say, try them anyway! 

 
Image > Rotate > Free Rotate 

This can be handy for 
straightening horizons which are 
slightly askew. Just enter the 
correction you require – usually 
much less than you think, often 
around 2o. 
 
It is easier see if the horizon is 

level if you turn on the option to place a grid over your picture.  Use View > Grid to turn this 
on. Unfortunately the rotate tool does not have a preview option so you usually have to make 
several attempts, undoing each guess until you get it right. 
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13. Magic with pictures 
 

Most of the tools do predictable and reasonable things – until you turn them up to maximum 
and things become psychedelic. However there are other tools which can do the kind of 
magic that which no one can detect.  

 

Cloning 
Whether it’s erasing an ugly relative, clearing the cars from an Italian square or just removing 
a spot from a sensitive teenager, the Clone tool is your friend. It allows you to replace one 
part of a picture with another. 
 

After the clone button has been left clicked the next step is to select the area which 
you will use to replace the part of the picture you don’t want. For example some grass 

could be used to remove an unwanted something or someone on your lawn. Right click on 
your ‘donor’ area, give yourself enough room around the donor point to cover your target. 

 
Unfortunately this is difficult to show on paper. In 
the example on the left I have started to remove a 
cyclist from the front of a Dutch shop. 
 
You can see that parts of him appear transparent 
– that is where other parts of the picture have 
been copied to replace the parts he was 
obscuring. You can only do this if you have 
enough suitable donor material. 
 
Once you have selected your donor area (by right 
clicking on it) you carefully paint over the 
unwanted areas by dragging the cursor with the 
left button across it, an ‘X’ marks the area you are 
copying from. 

 
It takes time to do this well and when you have finished you may want to use the Blend or Blur 
tools to soften the edges of your rebuilt picture. When you are replacing something large it is 
common to run out of ‘spare’ picture and have to reuse the same part many times – which can 
look odd. Smaller areas, like spots, closed eyes or wild hair or much simpler. 
 
‘Brushes’ have a lots of options, size is the most important but the others can be useful. It is 
usually necessary to reduce the size of the ‘brush’ to finish fine details and the boundaries 
between copied areas. 
 

 
 
Shape:  a round brush is usual but square ones are good for finishing corner details 
Hardness:  whether the brush edge is sharp or soft – sharp can look unnatural 
Opacity:  sets whether the brush completely covers the old picture at its centre 
 



Making the most of your digital camera 

20 

14. Case study 1 – Fixing a backlit face. 
 
It’s not always possible to take the perfect picture, even with a brand new digital camera to 

make all the clever adjustments for you! 
 
One common problem is that the camera’s automatic systems are 
fooled by strong backlight. They often do not understand that while on 
average the picture is well balanced the point of interest has been 
underexposed. 
 
In fact many cameras have a mode which will help with this and 
forcing the flash on to use it in ‘fill’ mode would too. Unfortunately the 
need is often only apparent after the moment has passed. 
 
In this unsightly example the sun is behind 

the subject so the face is in shadow. I want to lighten the face slightly 
to better centre the composition. 
 
The first step, since I want to limit my changes to the face, is to make 
a freehand selection of just that area. 
 
Deciding the edge of the select is difficult as the beard is not a clearly 
defined border – it is however a ‘fuzzy’ area where blending between 
new and old should be quite easy. 
 

The second and third steps are to try to get 
the face lighter while keeping it a good match 
for the rest of the picture. I first used 
Colours > Adjust > Brightness/Contrast 
to increase both the brightness and contrast 
of the face. This has left our victim looking a 
bit red in the face.  
 
I left that stage out as the next is more 
subtle, so more interesting. 
 
We can use the similar looking 
Colors>Adjust>Hue/Saturation/Lightness 
tool to fine tune the colour match of the 
selection Darker areas often hold stronger 

colour, the first thing I did was to turn down the saturation to get a more neutral skin tone. 
Then I used the Hue control to select a yellower skin tone (by trial and error) – more summery 
and less alcoholic! 
 
At a distance it may look as though the work is now done but the selection 
will leave a transition border which would be apparent on close 
examination.  
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A combination of first ‘smudge’ (left) and then additional ‘blur’ (right) have been used to soften 
the transition edge at the hairline.  
 
For a small print this doesn’t need to be perfect, just 
unobtrusive. 
 
Similar methods can be used to blend the line across 
the beard, using lots of small strokes instead of large 
sweeps will break up the edge. 
 
There is a different problem where the selection has accidentally included a small piece of 
sky. This sliver has been brightened and desaturated so it is very obvious. 
 

Using the clone tool I can paint away the bright area. 
Select a clone source point at the same height as the 
start of the sliver as in most pictures the sky has at least 
a very slight gradient (it is lighter blue at the horizon and 
darker higher up). 
 
The clone brush has a soft edge so I overlap the edge of 
the face until the blue of the sky replaces the bright 
sliver and slightly blurs the beard. 
 
Again this is a small detail which just needs to be tidied 
enough to be invisible from distance. 
 

 
At the end of the process the picture looks quite 
natural but perhaps a bigger improvement would 
have been to replace the face completely! 
 
If you decided to replace the face with something 
more appealing it’s worth knowing that it’s possible 
to clone from one picture to another in Paintshop 
Pro. Thus if you have a picture of Aunt Doris smiling 
from one social gathering, you can use it to replace 
her scowl at her least favourite niece’s wedding. 
 
We cover cloning in the next section. In fact the 
cloning is the easy bit. The hardest part is getting 
the scale of both pictures identical – but perhaps if 
you don’t like Aunt Doris she’d look better with a 
shrunken head! 
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15. Case study 2 – Removing innocent bystanders 
 
Whether or not you are a brilliant photographer you can’t always control the public, especially 
around tourist attractions. Many pictures are spoilt by inconvenient bodies, but luckily they are 
often easy to remove. 

 
This picture of the Aldeburgh scallop has a spare person 
sprouting out of the beach. 
 
She is easy to remove. She is clear of the detail of the main 
subject of the picture and she is covering easy to match natural 
detail – sky, sea and gravel. 
 
That wouldn’t be much of an example would it? 
 
It is much more difficult to replace areas which are important. In 
the second picture an awkward chap is obscuring an edge of 
the sculpture. To be honest if this happened I’d wait and take 
another picture but for the sake of demonstration lets say that 
200 peace protesters occupied the beach and this was the best 
I could get. 
 
To do this we will use the clone tool to replace our art lover and 
rebuild the shell. 
 
The most difficult part will be to successfully finish the edge of 
the new shell so that it appears natural and is actually true to 
the original. This is going to be tricky. 
 
Lets start with something simple, the hand on the front of the 

shell. By using the clone tool several times to 
‘stamp’ small areas of clone the edge can be 
rebuilt. 
 
In the snapshot on the left ‘X’ marks the clone 
source and as you see the edge has aligned well, 
but I also have a trace of the weld. That’s easy to 
remove by cloning a nearby part of the shell. 
 
Choose a part with the same 
contours and lighting (right). 
 
That was easy… now for the 
difficult bit. 
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To recreate the rear shell we will have to use the limited parts we have and extend them to 
cover our nemesis. This is best done along some form of reference since we hope to maintain 
the flutes of the shell. Picking a clone source on a weld I can click further down it and paint a 

repeat of the clear area of the shell. 
 
This works well but the problem is 
that I have so much to replace that I 
have to repeat the clone area twice 
(points a and b) which may be 
obvious later unless we blend them 
away. 
 
Producing the replacement shell is 
just repetition of this process, running 

the clone brush along each seam in turn and then blending in any obvious cock-ups where 
cloned areas meet. 
 
We use the seams since if we right click to 
select the clone source on a seam and then 
start to ‘paint’ with the clone brush further 
along the same seam it will appear 
continuous. 

 
Once you have enough shell we can use a clone 
brush starting at a clear part of the sea/beach or 
sea/sky line to cut back the edge of the shell. 
 
It would help if you knew what the edge of the 
shell looked like but away from the original few 
people will quibble. 
 
Tidying away the remains of our intruder and his 
dog walking friends will be a piece of cake in 
comparison. They just need to be replaced with 
areas of beach, sea and sky. These are natural 
textures and clone in easily and seamlessly.  
 
Even without working on the repetition from the 
cloning to rebuild the shell the result looks quite 
convincing as the welding has a certain 
regularity to it in any case. 
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16. Appendix - A short Digest of useful information 
 

Cameras 
www.cameradepot.co.uk and www.digitalcameras.com are good on some accessories 
 
Jessops (www.jessops.co.uk) will sometimes match web prices from UK companies 
 
www.ebay.co.uk has some amazing offers but can attract tax and risk. 
 

Camera Reviews 
These offer comprehensive reviews of most cameras, read with care as they may not be 
looking for the same features as you and tend to discuss American prices.. 
www.imaging-resource.com - www.dpreview.com - www.steves-digicams.com 

 
Cheap memory cards etc 
www.7dayshop.co.uk are very good for general supplies – particularly batteries, paper and ink 
 
www.digitaldepot.co.uk are very good on memory cards and particularly Olympus cameras 

 
Ideas 
www.webphotoschool.com  This is one of several collections of tutorials on the web. 
 

Price comparison sites 
All have rather selective coverage, best to try them all 
www.dealtime.co.uk - www.pricerunner.co.uk - www.kelkoo.co.uk 
Searching on www.google.co.uk or www.ebay.co.uk can often turn up better deals  
 

Printing 
www.jessops.com Have do it yourself print systems in store and offer online printing (with 10 
free 7x5” on your first order). Only offer traditional print sizes – often offer 50 prints for £5 
 
www.boots.com Have ‘do it yourself’ and ‘bulk’ systems in store – Only offer traditional print 
sizes – often offer 50 prints for £5 
 
www.photobox.co.uk One of the best online printers, they often have offers on large prints 
 

Free Software 
www.irfanview.com A free program that will quickly view pictures, create slideshows and 
screensavers as well as resizing and converting files. 
 
picasa.google.com (N.B. No www.) A free program from the Google people which offers 
useful editing and some extras like webpage, screensaver and slideshow making 
 

Web galleries 
 
fotopic.net These people (based in the UK) offer 250Mbytes of space for pictures on a site 
which will automatically produce attractive galleries. The site is free. 


